
 NutriSoft Heart Perfect Help Index

NutriSoft Heart Perfect is an indispensable tool to those with high risk for coronary heart 
disease to monitor their diet and to control their weight. The program is based on the U.S. 
Surgeon General's dietary guidance and on studies of the National Institutes of Health.

Some of the more important enhancements in version 2.3 include:
- convenient food search capability,
- user's food database support,
- printer font and screen color selection,
- graphic analysis of nutrients,
- RDA analysis,
- food list sort (on specific nutrient) capability.

For a hard-copy of Heart Perfect documentation, please print the file 'manual.wri' via the 
Windows 'write' program.
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File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print Prints a document.
Print Setup Selects a printer and printer connection.
Exit Exits NutriSoft Heart Perfect.



View menu commands

The View menu offers the following commands:

Caloric Analysis Shows graphic analysis of percentage of calories from 
protein, carbohydrate and fat.

Nutrient Analysis Shows graphic analysis of the individual nutrient contents 
from your daily food consumption.

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Tools menu commands

The Tools menu offers the following commands:

Weight Control Plan Use this dialog box to set short and long-term plan for 
weight control.

Desirable Weight Determine your ideal weight based on your sex, height and
body frame.

Caloric Need Find out your daily caloric need.



Options menu commands

The Options menu offers the following commands:

Search Mode Allow you to search for any specific food 
from the standard and personal food 
databases.

Food Groups Mode Display food items according to food 
groups.

Personal Food Database Display food items from your personal food 
database.

Choose Printer Font Select your favorite printer font for your 
nutritional and weight planning report.

Choose Screen    Color Select your favorite color for your screen 
background.

Set Nutrient Intake 
Preference

Set your preferred ranges of nutrient 
intakes. The color of the RDA analysis bars 
will reflect your preference.

Set Fat Warning Level Set threshold beyond which you are alerted
when a food item has more than certain 
percentage of calories from fat.



Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple documents in the application window:

Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 
2, ...

Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new document in NutriSoft Heart Perfect.
You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document in a new window.    You can open multiple 
documents at once.    Use the Window menu to switch among the multiple open documents.  
See Window 1, 2, ... command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open.

Drives
Select the drive in which NutriSoft Heart Perfect stores the file that you want to open. 

Directories
Select the directory in which NutriSoft Heart Perfect stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    NutriSoft Heart 
Perfect suggests that you save changes to your document before you close it.    If you close a
document without saving, you lose all changes made since the last time you saved it.    
Before closing an untitled document, NutriSoft Heart Perfect displays the Save As dialog box 
and suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown 
below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When 
you save a document for the first time, NutriSoft Heart Perfect displays the Save As dialog 
box so you can name your document.    If you want to change the name and directory of an 
existing document before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    NutriSoft Heart Perfect displays 
the Save As dialog box so you can name your document.    

Important:
You should save all your files in the directory where you install NutriSoft Heart Perfect. The 
Weigh Control planner will look for them in this directory.

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    NutriSoft Heart 
Perfect adds the extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Important:
You should save all your files in the directory where you install NutriSoft Heart Perfect. The 
Weigh Control planner will look for them in this directory.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want 
to open.



Exit command (File menu)

Use this command to end your NutriSoft Heart Perfect session.    You can also use the Close 
command on the application Control menu.    NutriSoft Heart Perfect prompts you to save 
documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in NutriSoft Heart Perfect, such as File Open.    A check mark 
appears next to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in NutriSoft Heart Perfect,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document.    NutriSoft Heart Perfect displays the Open dialog box, in 
which you can locate and open the desired file.

Save the active document or template with its current name.    If you have not named
the document, NutriSoft Heart Perfect displays the Save As dialog box.

Print the active document.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the NutriSoft Heart Perfect window.    To display 
or hide the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



1, 2, ... command (Window menu)

NutriSoft Heart Perfect displays a list of currently open document windows at the bottom of 
the Window menu.    A check mark appears in front of the document name of the active 
window.    Choose a document from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using NutriSoft Heart Perfect and various types of 
reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

NutriSoft was established by a group of Stanford University researchers to provide 
consumers
with quality software to help them achieve better health. Your suggestions and comments on
our
products are much appreciated. Please write to us at the following addresses:

US Mail: P.O. Box 8226, Stanford, CA 94309
America Online: NutriSoft
Internet: NutriSoft@aol.com

We welcome inquiry from authors, institutions, and publishers who would like to distribute 
our products or license our software to use with their own nutritional data.

List of software products released by NutriSoft as of December, 1993:

Fat and Cholesterol Counter for Windows, v. 1.1 ($19)
This program is a perfect companion to American Heart Association's Fat and Cholesterol
Counter, a guide for everyone who wants a more healthful diet.

Control Diabetes for Windows, v. 1.2 ($29)
Essential tool for accurate monitoring of diabetic diet.

NutriSoft Weight Perfect for Windows, v. 2.0 ($35)
The next generation of nutritional software: flexible and powerful. Indispensable to anyone 
who wants to achieve a more desirable weight.

NutriSoft Pregnancy Nutrition for Windows, v. 2.1 ($39)
The program, developed from the latest findings of the American Academy of Pediatrics and 
the National Academy of Sciences, is the best nutrition software for a mother's health and 
that of her child.

NutriSoft Control Hypertension for Windows, v. 2.3 ($39)
The program is based on the report of the Joint National Committee on Detection, 
Evaluation, and Treatment of High Blood Pressure. An excellent nondrug approach to 
treatment for and prevention of high blood pressure.

NutriSoft Heart Perfect for Windows, v. 2.3 ($39)
The most effective dietary strategy to reduce heart disease risk.



Context Help command 

Use the Context Help command to obtain help on some portion of NutriSoft Heart Perfect.    
When you choose the Toolbar's Context Help button, the mouse pointer will change to an 
arrow and question mark.    Then click somewhere in the NutriSoft Heart Perfect window, 
such as another Toolbar button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the NutriSoft Heart Perfect window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    NutriSoft Heart Perfect 
determines which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    NutriSoft Heart 
Perfect determines which window is previous according to the order in which you opened the
windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Choose Font dialog box

Select your favorite font for printed report of nutritional analysis or weight control plan.



Modifying the Daily Food Consumption

To modify a daily food consumption document, you first select a meal you want to record the
data for. There are 6 meals in a day: Breakfast, Morning Snack, Lunch, Afternoon Snack, 
Dinner and Evening Snack. Select one from the left pull-down list box. 

Then you select a food group from the right hand side pull-down list box. (There are 
approximately 30 food groups.) It is easy to get to the food group you want: once the input 
focus is at the food group combo box (by tabbing to or clicking the mouse on this control), 
you can type just the first letter of the food group and the next group name starting with 
that letter will be displayed. Repeating a character will cycle all the group names with that 
starting character through the combo box.

[Alternatively, instead of the Food Group mode, you can specify the Search mode from the 
Options menu. Or you can use your own food database.]

Select a food item in the right listbox, click on the 'I Eat' button. This item will be recorded in 
the meal you selected.
Starting with version 2.3 of our software, you can sort the food list on any 
individual nutrients. Select either the ascending or descending order via the blue 
or red triangular sort icons near the lower right corner of the food list box, a 
floating menu will appear inside the listbox, you can then select the nutrient you 
would like to sort on. Once the list box is sorted, you can single click on a food 
item to review its nutrient's content. A sort is valid only for the current content of
the list box, this means if you move to another food group or do another food 
search, the new content will be listed in alphabetical order (except for the search 
content). When the list box is sorted, a small square appears inside a sort icon to 
indicate which sort sequence is in effect.

If necessary, you can adjust the number of servings for this food item by typing the desired 
amount in the edit control above the 'Am(oun)t. OK' button. Once the right amount has been
typed in, click on 'Amt. OK' to confirm and record this value.
For your convenience, we have provided 2 popup menus which you can use to 
quickly adjust the amount of servings: a left mouse button click anywhere on the 
background of the document window will display a selection of common serving 
sizes; a right mouse button click will display a selection of common servings in 
ounces. When you release the mouse button after selecting an entry, the amount 
in the edit box and other data will be updated automatically.

If a food item is not what you intended to add to a meal, you can highlight it and then click 
on the 'Delete' button to remove it from your meal.
Starting with version 2.3, you can display the graphic caloric analysis of a food 
item in a meal by selecting an entry in your meal food consumption then click on 
the graph icon. A graph will appear to show you the percentages of calories of 
this food item that come from fat, protein and carbohydrate. To review the caloric 
analysis of your day food consumption, select the 'Caloric analysis...' menu item from the 
'View' menu.

Repeat the food selection process for each meal, omitting the meals where you don't eat 
any food.

When you are done, you can save the day food consumption data for later review or for use 
in your weight control planning.

The number of document windows (files) you can leave open simultaneously depends on 



your computer's resources. On system with low memory resources, the screen may not look 
correct if you have too many document windows open. When the screen is not displayed 
properly, just close one or two document windows and everything will return to normal.

Important:
The RDA analysis is color coded as follows:

- yellow : below RDA i.e., too little
- green : within RDA i.e., just about right ( 91 - 110 % )
- 
magenta

: above RDA i.e., more than enough

- red : well-above 
RDA

i.e., much more than needed

In general, you should strive to achieve a balanced diet which is reflected by the green bars 
the analysis displays. Excessive consumption of certain nutrients is not desirable.

You can set your own preferred nutrient intake levels and the analysis colors are modified 
accordingly: a yellow bar is displayed when the current intake is below your desired range; 
green when within range; magenta when moderately above range and red when much 
higher than your preferred range.

Strictly speaking, there is no RDA for carbohydrates. However, the Food and Nutrition Board of the 
National Academy of Sciences recommends that more than half the energy requirement beyond infancy 
be provided by carbohydrates. 

Note:
To refresh the RDA percentages after you change the personal information in the "Caloric Need..." dialog 
box or when they are not displayed, click on the "Amt. OK" push button.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Desirable Weight

This dialog box calculates the desirable weight based on a person's height, sex and frame. 
The desirable weight is that associated with lowest mortality.

To plan your weight loss use Weight Control Plan.

Use the spin controls to specify your height (without shoes) and frame. Specify your sex by 
selecting the appropriate radio button.

If you close the dialog box by clicking the OK button, the information will be saved and 
redisplayed next time you invoke the dialog box. Use the Esc key to close the dialog box 
without saving.



Set Fat Warning Level

"Because fat contains more than twice the caloric value per gram of either protein or carbohydrate, the
general public would benefit from reduced fat intake." 

U.S. Surgeon General

Is this food too fatty? Use this dialog box to set the threshold when NutriSoft Heart Perfect 
should warn you when a food item exceeds the limit. A green or red symbol is displayed 
appropriately. You can click on the symbol to invoke the dialog box.

When you print out your nutritional analysis of your diet, each fatty food will also be marked 
with an asterisk for easy recognition.



Caloric Need and Nutrient Requirements

This dialog box calculates your daily caloric need and recommended intakes of important 
nutrients according to your age, ideal weight, activity level.

Specify your age, ideal weight and activity level using the spin buttons. Activity level ranges 
from 1 (sedentary) to 10 (strenuous). 

Suggested total fat intake is based on the American Heart Association's and the Food and 
Nutrition Board's recommendation that no more than 30% of your calories come from fat. 

Recommended intakes of other nutrients are based on the Surgeon General's 
recommendation and on the National Research Council's data.

To leave the dialog box, click on the OK button or select Close from the dialog box's system 
menu or hit Esc. If you click OK, the current information is saved for next time you invoke the
dialog box.

The dialog box must be filled out at least once: when you run the application for the first 
time, the dialog box is automatically presented to obtain your individual information. You can
revise the information anytime.



Weight Control Plan

It's hard to achieve your weight goal without planning. This utility allows you to establish a 
plan and estimate precisely how much weight you will gain or lose when you follow this plan.

Heart Perfect plan is truly flexible: you can set a food plan to be repeat every week, every 3 
days or every 10. 

Once an entry is added into your plan, you can select it then click on the 'chart' button to 
review its nutritional content. Please note that you must have previously saved some files 
before you can use this dialog box. Or you can try out the sample daily food consumption 
files we provide.

After setting up your plan, print out a report to keep track of your food intake and to 
motivate yourself to achieve your goal.



Nutrient Analysis

Do you know which meal provides you with the most protein in your diet? With the most fat?
This graph displays the percentage of each nutrient consumed during each meal of the day.

Select 'Protein' from the combobox and the graph shows the percentage of protein that 
comes from breakfast, morning snack, lunch, afternoon snack, dinner and evening snack in 
counter clockwise order. 

The analyses are provided for weight, calories, protein, carbohydrate, fat, and other 
essential nutrients.

To leave the dialog box, click on the OK button or select Close from the dialog box's system 
menu or hit Esc. If you click OK, the currently selected nutrient will also be initially selected 
next time you invoke the dialog box.



Caloric Analysis

These 2 graphs provide information about the nutrient contents of your food intake for the 
current day or for that previously saved in a file.

The left graph shows the weight in grams of protein, carbohydrate and fat in the day's food 
consumption. The right graph shows the day's caloric intake and a pie chart depicting the 
percentages of calories from protein, carbohydrate and fat in counter clockwise order. Each 
nutrient is color coded for easy idenfication.

You should pay particular attention to the percentage of calories from fat. The American 
Heart Association recommends that your total fat intake be no more than 30 percent of your 
total calories.

To leave the graphs click the mouse anywhere inside them or hit the escape key.



Search mode

This is one of the most convenient features of NutriSoft Heart Perfect. It allows you to find 
any particular food items from the standard and user databases without your having to 
browse through different categories of food groups.

When this mode is selected, an edit control is displayed in place of the Food Group combo 
box. You type in the name of the food item you want to find, for example "apple", then click 
on the Search push button (or type Alt-S). The list box will be filled with all food items 
containing "apple". You don't need to type in a complete word: "app" will suffice. On the 
other hand, when there are too many matching food items, you might want to restrict the 
match by specifying longer name such as "apple juice". The search is not case sensitive: you
can use lower or upper case letters and this won't affect the result.

The program will look for matching entries not only in the standard food database that 
comes with your software but also in your own personal food database.

The matched food items displayed in the list box can be selected as those in any other 
mode.

In the registered version of the software, there is no restriction on the size of the user 
database on which the search will be performed. However, memory limitation of your 
system might prevent the display of all matched entries in the list box. In this case, a 
message box will appear to alert you of this situation.

In the shareware version, search will be performed on the abbreviated standard database 
and on the first several records of the user database.



Food Groups Mode

In this mode, the default mode, you will see a pull down listbox that contains approximately 
30 food groups such as "Beverages", "Oils", "Beef", etc. By selecting any of these food 
groups, the food items belong to the group will be displayed in the list box immediately 
below. This mode is useful when you want to browse through the standard database, or 
when you want to do your menu planning which requires selection of foods from different 
food groups.



Personal Food Database

Naturally, not all foods in your diet are listed in the standard database. What do you do 
when you've just eaten a serving of Haagen-Dazs ice cream? Or want to include a favorite 
TV dinner in your weekly plan? Most of these items do have nutritional information on their 
packaging. NutriSoft Heart Perfect can access and use their nutritional information once 
you've entered the data into your personal food database.

Choosing Personal Food Database from the Options menu will display all food items from 
your    database in the listbox. This mode is convenient when your diet consists mainly of 
special food items or when you just want to browse the contents of your data.

The capability to process user's food data is one of the important enhancements in this 
version of NutriSoft Heart Perfect. The user food database is a file named 'userfood.txt'. The 
file can be edited using any plain text editor such as the Windows's notepad program. You 
can also use a database program such as Access, FoxPro, or Paradox, etc. or any 
spreadsheet program such as Excel or Lotus 1-2-3 to create this database and export/save 
the database to/in the plain text format. 

The format of each record (entry, line) in this database is:
- food name in double quotes ( e.g., "Quarter Pounder with Cheese" )
- weight of food in grams (e.g., 250 )
- calories from food in Kcalories (e.g., 300 )
- protein from food in grams (e.g., 30)
- carbohydrate from food in grams (e.g., 150)
- fat from food in grams (e.g., 50)
- saturated fat from food in grams (e.g., 42)
- cholesterol from food in milligrams (e.g., 120)

Each food item must be stored on a single line and each nutrient information is separated 
from one another by a comma so the above food item is recorded as:
"Quarter Pounder with Cheese", 250, 300, 30, 150, 50, 42, 120
Space(s) before or after the commas is optional.
Please print out the file 'userfood.txt' for sample entries.



Choose Printer Font

Use this option to select the printer font for your Nutritional Analysis Report and Weight 
Planning Report.



Choose Screen Color

Use this option to select the color for your screen background.



Set Fat Warning Level

This option allows you to specify the percentage of calories from fat above which you want 
to be alerted. For example, if you want to identify foods that has more than 50% of their 
calories derived from fat, you should set this value through the Set Fat Warning Level dialog 
box. From then on, each time a food item is consumed, a green or red symbol will be 
displayed to indicate whether its fat content is below or above the limit you set. When you 
print out your nutritional report, each food item exceeding this limit is also flagged with an 
asterisk before its name.



Set Nutrient Intake Preference

How much of each nutrient do you want to consume each day? The color of the RDA analysis
bars will reflect your preference. The bars are green when you consumption is within your 
preferred range, yellow when you are not having enough of a nutrient, magenta when your 
intake is somewhat above the optimal range, and red when the consumption is considerably 
higher than desired.

Click on the Use RDA button if you want the Recommended Daily Allowance value for any 
particular nutrient. Please note that the RDA values are for an average individual. You might 
need to adjust your optimal intake accordingly.



Caloric Analysis (View menu)

Do you need a more healthful diet? This menu item displays a graph showing the number of 
calories in your diet that comes from protein, carbohydrate or fat.



Nutrient Analysis (View menu)

Are you eating too much at dinner and not enough at breakfast? Check out the relative 
nutrient intakes of all your daily meals.



Weight Control Plan (Tools menu)

It is now so easy to establish a sensible plan to control your weight. Your plan can be set for 
any number of days. Find out how much weight you will gain or lose in a week, a month or a 
year; and whether you are consuming too much fat in your plan.



Caloric Need (Tools menu)

Find out how many calories you need a day based on your age, desirable weight and activity
level. The dialog box also shows the maximum recommended fat consumption in your diet.



Desirable Weight (Tools menu)

This menu item displays a dialog box which allows you to determine your ideal weight based
on your sex, height and body frame.



What Can NutriSoft Heart Perfect Do?

These are a few things NutriSoft Heart Perfect can do for you:

1. NutriSoft Heart Perfect can help you determine your ideal weight and set up an
optimal weight loss plan.

2. NutriSoft Heart Perfect can help you identify excessive cholesterol 
consumption in your diet.

3. NutriSoft Heart Perfect can help you determine and achieve an adequate 
energy intake.

4. NutriSoft Heart Perfect can help you achieve ideal levels of fat and 
carbohydrate intake.



Registration Form
[This form can be printed by selecting 'Print topic' from the File pull-down menu.]

Please indicate which software product(s):

1. Fat and Cholesterol Counter for Windows, v. 1.1 ($19)

2. Control Diabetes for Windows, v. 1.2 ($29)

3. NutriSoft Weight Perfect for Windows, v. 2.0 ($35)

4. NutriSoft Pregnancy Nutrition for Windows, v. 2.1 ($39)

5. NutriSoft Control Hypertension for Windows, v. 2.3 ($39)

6. NutriSoft Heart Perfect for Windows, v. 2.3 ($39)

Name:

Address:

City: State: Zip:

How did you obtain this NutriSoft shareware? _____________________________________

Comments and suggestions:

Please send check or money order to
NutriSoft

P.O. Box 8226
Stanford, CA 94309

Foreign order: please remit in U.S. currency and add $1 for airmail postage.



How to Use the Program

NutriSoft Heart Perfect can do many useful things for you:

At the simplest level, it can determine your ideal weight and recommend the most healthful 
levels of nutrient and caloric intake to you. You can browse through the food database and 
select the foods that provide the nutrients you need and avoid those that have too much fat 
or cholesterol, for example. Or you can view and print graphic analysis of your diet.

However, the two most important uses of    NutriSoft Heart Perfect are to analyze your 
current diet and to establish a weight control plan.

A typical scenario for the former case:    you record the foods you eat at each meal during 
the day, then print out the analysis to see if your current diet is too high in salt, deficient in 
calcium, etc.    You can also determine if your caloric intake is spread out rather evenly 
throughout the day or heavily concentrated at dinner time. [Some weight control plans 
recommend that the caloric intake is spread out evenly throughout the day.] Using the 
caloric analysis dialog box, you can also determine if too many calories in your diet come 
from protein or fat and modify your diet accordingly. Make sure you print out a hard copy of 
the analysis for a comprehensive view of your day diet. Each day's food data can be saved 
for later use. You can save the files as Mon, Tue, Wed or 0925 (for September 25th) or day1, 
day2, etc., the program will automatically add in the file extension. Use whatever file names 
that you can easily remember, some examples are 'meat' for the day you eat meat; 'pasta', 
'chicken', 'ham' are all good names.

To establish a diet plan to gain or lose weight, you prepare the menu for each day recording 
the foods you are going to eat for each meal. For simplicity, let's assume you are going to 
repeat the menus every week. In this case, you will prepare 7 files (naming them Sun, Mon, 
Tue, Wed, Thu, Fri and Sat) and record the foods you plan to eat for each meal in these files. 
Once these files are saved, you bring up the Weight Control Plan dialog box. The files should 
show up in the right list box. You then add all 7 files to your plan. After adjusting your weight 
and activity level, you will have an accurate picture of how much weight you will gain or lose
when you follow this plan of diet. You can go back and adjust the food data in the files if you 
find that you are eating more or less than what is required to achieve your weight goal.



Introduction

Coronary heart disease accounts for more deaths annually than any other disease or group 
of diseases. More than 1.25 million heart attacks occur each year, and more than 500,000 
people die as a result.

Coronary heart disease (CHD) is a term used to identify several cardiac disorders resulting 
from inadequate circulation of blood to local areas of heart muscle. The development of CHD
is a silent process generally lasting decades before the onset of symptoms, therefore 
prevention of CHD must focus on identifying and modifying risk factors before clinical 
disease develops.

The causes of CHD are multifactorial. It is generally accepted that high blood cholesterol, 
high blood pressure, and cigarette smoking play causal roles in the development of 
atherosclerosis, which leads in turn to narrowing of the arteries and development of CHD. 
Diet plays an important role in the regulation of blood cholesterol levels and influences other
risk factors for CHD as well. For millions of Americans, the most effective CHD preventive 
strategies are to avoid smoking cigarettes, to avoid obesity, and to lower high blood 
cholesterol.

High blood cholesterol is one of the three major modifiable risk factors for CHD. The principal
nutritional factors identified with high blood cholesterol and the development of CHD are 
dietary fat (particularly saturated fatty acids), cholesterol, and energy imbalance leading to 
obesity.

The relationship of dietary fat and choleterol to CHD is supported by extensive and 
consistent clinical, epidemiologic, metabolic, and animal evidence. These evidences provide 
strong support for recommendations for an overall considerable decrease in dietary fat and 
cholesterol intake by the general public.

Obesity is associated with many important CHD risk factors such as hypertension as well as 
high blood cholesterol, etc. and hence increases the risk for CHD. The association of weight 
with CHD incidence was most pronounced in those under age 50. Weight gain in adulthood 
conveyed an added risk.

On the other hand, diets containing 60 to 70 percent of calories from carbohydrate, such as 
those consumed in Asian countries, are associated with low plasma cholesterol levels and a 
low risk for CHD. Such diets tend to be relatively high in fiber and very low in fat and thus 
have been widely advocated for the treatment of hypercholesterolemia.

Diet is the cornerstone of therapy to reduce blood cholesterol level whether or not drug 
therapy is eventually added to the regimen. In general, drug therapy is not recommended 
without at least 6 months on optimal diet. NutriSoft Heart Perfect helps you identify and 
eliminate high-fat, high-cholesterol foods from your diet. It also helps you set up plan to 
achieve a desirable weight and avoid obesity. As a result you can obtain the benefits without
the risk associated with side effects of lipid-lowering drugs. Studies have shown that many 
CHD patients can reduce their cholesterol levels substantially with diet alone. When drugs 
are required, simultaneous modification of the diet may reduce their dosage requirements, 
cost and potential side effects. According to the National Cholesterol Education Program 
adult treatment guidelines, over 40 million adult Americans could benefit from dietary 
education and treatment.





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>




